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Sections and Timing

This exam has two sections: a section with questions you will answer in this window and a section with tasks you will perform in
InDesign.

You will have 50 minutes to complete both sections.

Timer Starts Timer Continues

Tutorial Section Tutorial Tasks Section Leave
Summa Summa Feedback

After completing the first section, you will see a Section Summary page that allows you to review only the questions in that
section. You will not be able to revisit those questions after you select the Submit Section button on the Section Summary page.

Next, you will see a tutorial that will help you complete the InDesign tasks. Tutorials are not timed. After you complete the second
tutorial, you will complete the tasks. You will be able to review only the InDesign tasks from the second Section Summary page.
At the end of the exam, you will have the opportunity to leave feedback on questions, tasks, and the exam as a whole.

Select the Next button to proceed through the tutorial.
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Question Section Navigation

The questions have controls at the top and bottom of the screen that allow you to progress through the section. The following image
shows these controls:

1 2 3
Question 10 of 10 00:21:22

Match each term with its definition.

4

I

Answer Area
Milestone Scope creep Wireframe

A request that causes the cost or timeline of the
project to increase.

5 _} A significant event in the project schedule

A blueprint that shows the information hierarchy

m ] Mark for Review ] Leave Feedback
6 7

8 9 10 11

1. Identifies the question you are completing and the total number of questions in this section. Monitoring your progress using these
numbers will help you ensure that you have enough time to complete all questions and tasks on the exam.

2. Reports how much time you have remaining to complete the exam. Time is shown in hours:minutes:seconds.

. Use the Reset Question button to reset all selections on the question. For example, in a Matching item like the one shown above,
selecting Reset Question returns all options to the list on the left.

. Use the horizontal splitter bar to change the percentage of the screen height used to display the question versus the answer area.

. Use the vertical splitter bar to change the percentage of the screen width used to display the options versus the answer area.

. Use the Back button to return to the previous question. Your response will be saved when you select Back.

. Use the Help button to display help for the specific type of question.

. Check Mark for Review if you want to remember to return to this question from the Section Summary screen.

. Check Leave Feedback if you want to remember to leave feedback on this question.

. Use the Summary button to view the list of all items in this section. You can return to any item from the Section Summary screen
to continue your work on that item. You can also exit this section of the exam from the Section Summary screen.

11. Select Next to save your response and proceed to the next question.
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Question Section Summary

After completing the final question, you
will reach the Section Summary page.

Each question you marked for review
will be indicated. You can navigate to
any question from this page. To return
to a specific question, select the
question number. To return to this page
from the question, select the Section
Summary button. After you finish
reviewing tasks, select the Submit
Section.

00:34:38

Section Summary

The table below shows a list of all the questions. Each question you Marked
for Review is indicated. To return to a specific question, select the question
number.

Questions Marked for Review

InDesign Questions

Question 1
Question 2 L]

Question 3

Question 4 -

Question 5

Question &

Question 7

Question 8

Submit Section
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InDesign Task Section

In the second section, you will complete tasks using InDesign. Each task is displayed in the Certification Test panel.

Most tasks begin with a starter document loaded. You do not need to save the document after you complete the task, unless you are instructed
to do so in the task. Your work on the starter document will be saved automatically when you select the Next or Back button.

Application

Vet @ B

Task 2 0f 18 00:34:22

Apply the Publication paragraph style 10 the body text.

WIDI ISLANDS

s bt St ] e

Starter document

™~
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% Summary

[ Leave Feedback
[ meark for Review

(<o 2 ] 7 o i Jl e >

Almost all application functionality is available to you to complete each task. You will receive credit for any method of completion that meets the

task requirements.

If InDesign crashes or you need to quit the application while you are taking the test, you can resume the exam where you left off. Your progress
will be saved for all tasks you submitted.

A few features will be blocked during the exam. These include:

* Open
* Help
» Adobe Bridge
» Adobe Stock

None of these features are necessary to complete the exam.
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Working with the Certification Test Panel

The Certification Test workspace contains only the
Certification Test panel. You will need to open other
workspaces or display other panels from the Window menu
in order to complete tasks. The Certification Test panel has
also been added to the default workspaces.

The Certification Test panel acts like any other panel in . You
can float it, dock it, resize it, and even close it. If you close
the Certification Test panel, your task and all navigation
buttons will disappear. To get the panel back, reset the
Certification Test workspace by selecting Window |
Workspace | Reset Certification Test.

Important: Do not reset any of the default workspaces.
Doing so will cause the Certification Test panel to be
removed from that workspace.

Window = Help
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Arrange | I
Workspace » | v Certification Test
Find Extensions on Exchange... [Atvanced]
Articles [Book]

CC Libraries [Digital Publishing]
Color 3 [Essentials]

v Control Ctrl+Alt+6 [Interactive for PDF]
Editorial » [Printing and Proofing]
Effects Ctrl+Shift+F10 [Typography]
Extensions » [Start]

Info F&

e » Reset Certification Test
Layers 7 New Workspace...
Links Ctrl+Shift+D Helets Wadopoce
Object & Layout 4 Show Full Menus
Output 3

Overlays

Pages F12

Stroke F10

Styles 2
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InDesign Task Navigation

The Certification Test panel includes the controls you need to navigate the exam and manage your time. The
following image shows these controls.

1. Identifies the task you are completing and the total number of tasks on the exam.
Monitoring these numbers will help you ensure you have enough time to complete
all tasks.

2. Reports how much time you have remaining to complete the exam.

Use the Reset Task button to reset the document to its starting state. You will need

to successfully complete the task again to score a point, so use this button with

caution.

4. Use the Back button to return to the previous task. Selecting the Back button saves
any work you have done on the current document.

5. Use the Help button to display general help for the InDesigh task item type. Note:
This is not an application Help button.

6. Check Mark for review if you want to remember to return to this task from the
Section Summary screen.

7. Check Leave Feedback if you want to remember to leave feedback on this task.

8. Use the Summary button to view the list of all items in this section. You can return
to any item from the Section Summary screen to continue your work on that item.
You can also exit this section of the exam from the Section Summary screen.

9. Select Next to save your document and proceed to the next task.

(98]

1 2 3

Task 2 of 6 00:44:47

Change the text on the Widi Isfands layer to small caps and adjust the font size
to 37 pt.

8
T 2
¢ _ Summary

[] Leave Feedback
6 —) [ Mark for Review

4 5 9
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Task Instruction

The text in the Certification Test panel
describes the task you must perform to
receive a correct score.

Here are some guidelines to keep in
mind:

* You only need to change the
settings specified in the task. If a
setting value is not specified, keep
the default value.

* Do not make any additional
changes to the starter document.
For example, only change layer
names and groups if the task
requires it.

» If you are asked to save or export
a file, always save it at the default
location or the location specified in
the task. Do not navigate to other
folders.

* Do not add assets to CC Library.

Italicized text refers to a filename you
must import or an existing part of the
document. For example, italicized text
might reference a layer or text in a
document.

Bold italicized text is text that you
must type.

The dotted underline indicates text that
you can click to copy and then paste
into InDesign. If you want to paste text
in a dialog box, copy the text before
opening the dialog.

The Exhibit tab provides reference
images to help you complete tasks. For
tasks that have exhibits, click the
Exhibit tab in the Certification Test
panel to see the reference image.
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Italic indicates a part of the document
or an asset.

Task 3 of 19 00:59:26

| Reset Task

Change the text on the Widi Isfands layer to small caps and adjust
the font size to 37 pt.

Bold italic indicates text you type.

Certification Test

Task 3 of 6 00:48:42

|9 Reset Task

Change the name of Layer 2 to Background.

T
Click to copy

Certification Test

Task 12 of 20 00:48:57

J Question || Exhibit |
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Task Section Summary

After completing the final task, you will
reach the Section Summary page.

Each task you marked for review is
indicated. You can navigate to any task
from this page. To return to a specific
task, select the task number. To return
to this page from the task, select the
Section Summary button. After you
finish reviewing tasks, select the Finish
Section button.

00:33:51

Section Summary

The table below shows a list of all the tasks. Each task you Marked for Review
is indicated. To return to a specific task, select the task number.

Tasks Marked for Review

InDesign Tasks

Task 1 i

Task 2

Task 3

Task 4

Task 5 4
Task 6

Task 7

Task 8

Task 9

Task 10 i
Task 11

Task 12
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Exam Feedback

After completing the task section, select the Leave
Feedback button to leave feedback on individual
questions or tasks.

@ Lecave Feedback

You will see the first question. Leave feedback on
that question by selecting the Leave

Feedback button. You can navigate through the
questions and tasks using the Next

and Back buttons. You cannot make changes to your
answers while leaving feedback.

To view a list of all questions and tasks, select the
Section Summary button to visit the Exam
Summary page. Each question or task you marked
for feedback is indicated. You can navigate to any
question or task from this page by selecting its
hyperlink. After you finish leaving feedback on
individual questions and tasks, select the Finish
Section button to view the Thank You page.

Select the Next button to leave feedback for the
exam. On the exam feedback page, you can provide
feedback using the prompts, or enter your own
feedback. Select the Next button to review your
Score Report.
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Exam Summary

The table below shows a list of all of the questions and tasks. Each task you
marked for Leave Feedback is indicated. To return to specific question or task,
select the question or task number.

Tasks Marked for Feedback

InDesign Questions
Task1
Task 2 L
Task 3
Task 4
Task 5 L
Task 6
Task7
Task 8
InDesign Tasks
Task1
Task 2 @
Task 3
Task4 4
Task 5 1=
Task 6

Leave feedback about the exam

You may enter feedback about the exam below
1. Tell us what you liked about the exam

2. Tell us what you didn't like about the exam
3. Did you experience any technical problems? If so, please descnbe them
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Score Report

You must select the Exit Exam button
to upload your score report. You cannot
save or print your Score Report while in
the exam. After your Score Report has
been uploaded, you can view and print
it by logging into the Certiport website.

E CERTIFIED ASSOCIATE

Exam Score Report

Print & Digital Media Publication using
Adobe InDesign CC 2019 (v 14.x)

| Required Score ' '

| Your Score

_ —
Waorking In The Design Industry 100% | Hequnred Score ?l][l
Project Setup and Interface 56% ‘T’Our Score ?38 |
Organizing Documents 33% )
Creating and Modifying Document Elements J6% _
Publishing Documents 80% | Pass | v |
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